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Feedback from yesterday:

The depth of material covered today was
15 responses

@ Too high level
@ Just right
@ Too detailed

)
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15 responses
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Feedback from yesterday:

The pace of the lab today was
15 responses

@ Too fast
@ Just right
@ Too slow

Please add more

information about how
to use your cell phone!




Keyword Spotting in
One Slide

If we pick a simple
task to only
identifying a few key
words we can then
use a

and train it with little
data and fit it onto an
embedded device




By the end of today:
Hands-on Keyword
Spotting (KWS)

We will explore the
science behind KWS and
collect data and our
own custom model to
recognize “yes” vs. “no”
using Edge Impulse



Today’s Agenda

® A Quick Review of What We’ve Learned

e Data Engineering for KWS

® Hands-on KWS Data Collection with Edge Impulse

® Training our Model using Transfer Learning
Deploying our Model onto our Arduino

Summary



Today’s Agenda

® A Quick Review of What We’ve Learned

e Data Engineering for KWS

® Hands-on KWS Data Collection with Edge Impulse
® (Hands-on) Data Preprocessing for KWS

® Deploying our Model onto our Arduino

Summary
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Machine
Learning

INPUTS

WE PROVIDE

m Aka the Labels
of the Data

THE
COMPUTER
LEARNS
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Deep Learning
with Neural Networks
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Colab Link

Features can be found with Convolutions

f':! |‘
2 ” Hl':lh
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https://colab.research.google.com/github/tinyMLx/colabs/blob/master/2-3-3-ExploringConvolutions.ipynb

AlexNet Paper

Convolutional Neural Networks
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https://proceedings.neurips.cc/paper/2012/file/c399862d3b9d6b76c8436e924a68c45b-Paper.pdf

Camera feed

The TinyML Workflow

Collect Preprocess Design a Traina
Data Data Model Model

O0-0

Dataset Impulse

Evaluate Convert
Optimize Model

Test

?Starting inferencing in 2 seconds...
Taking photo...
Predictions (DSP: 9 ms., Classification:

‘ car: 0.07812
Make
Inferences

truck: 0.92188

Deploy
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Today’s Agenda

® A Quick Review of What We’ve Learned

e Data Engineering for KWS

® Hands-on KWS Data Collection with Edge Impulse
® (Hands-on) Data Preprocessing for KWS

® Deploying our Model onto our Arduino

Summary
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Data Engineering for KWS
(How to collect good data)

17



Data Engineering for KWS
(How to collect good data)

: e What languages will they speak?
Who will use your guages yop
ML del? e \What accents will they have?
moael: e Will they use slang or formal diction?
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Data Engineering for KWS
(How to collect good data)

Who will use your
ML model?

Where will your
ML model be used?

What languages will they speak?
What accents will they have?
Will they use slang or formal diction?

Will there be background noise?
How far will users be from the microphone?
Will there be echos?

19



Data Engineering for KWS
(How to collect good data)

What languages will they speak?
e \What accents will they have?
Will they use slang or formal diction?

Who will use your
ML model?

Will there be background noise?
e How far will users be from the microphone?
Will there be echos?

Where will your
ML model be used?

e What will be used?

e Are your used? (aka will
you get a lot of false positives)

e \What about false negatives?

will your
ML model be used?

those Keywords?
20



There are a lot more things to consider to
eliminate bias and protect privacy when

collecting data that we will talk about In
future sessions!




Tips and Tricks for Custom KWS

e Pick uncommon words for Keywords

e Record lots of “other words”

e Record in the location you are going to be deploying
e Get your end users to help you build a dataset

e Record with the same hardware you will deploy

e Always test and then improve your dataset and model

22



Today we are just working on a demo so to give our
demo the the best chance of working we will:

1. Stay in one spot (we’re cheating)

2.
3. Use common words (yes, no)

4. Only test ourselves

23



Today’s Agenda

® A Quick Review of What We’ve Learned

e Data Engineering for KWS

e Hands-on KWS Data Collection with Edge Impulse
® (Hands-on) Data Preprocessing for KWS

® Deploying our Model onto our Arduino

Summary
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The TinyML Workflow using Edge Impulse

Today we'll also collect all of our ...and deploy to your
data using Edge Impulse... cell phone as well
\/_

Collect Preprocess Design a Train a Evaluate Convert Deploy Make
Data Data Model Model Optimize Model Model Inference

O0-0-0—-0

Dataset Impulse Test Deploy

25



Dashboard

Edge Impulse Project Dashboard B Devices

Data acquisition

i

A\ Impulse design

® Create impulse

Collect Preproce Design a Traina Evaluate Convert Deploy Make
Data Data Model Model Optimize Model Model Inferences
@ EON Tuner

or0--0 | -

Live classification
Dataset Impulse Test Deploy

l\b
(]

Model testing
PP Versioning
g Deployment

26



Create an Edge Impulse Account

== EDGE IMPULSE

Create an Edge Impulse account:
https://studio.edgeimpulse.com/signup

Login

Validate your email by clicking the link in
the email sent to your account’s email
address

[ %
- e
Grm—

Start building embedded

machine learning
models today.
©2021 Edgelmpulse Inc. All rights reserved
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https://studio.edgeimpulse.com/signup

Activity: Create a Keyword Spotting Dataset
Collect of the following classes of data:
 Keyword #1 “yes” (label: yes) (length: 1 seconds)
 Keyword #2 “no” (label: no) (length: 1 seconds)

* “Unknown” words that are not the keyword and
background noise (label: unknown) (length: 1 seconds)

28



https://docs.edgeimpulse.com/docs/
pre-built-datasets/keyword-spotting

Activity: Create a Keyword Spotting Dataset
Collect ~30 samples each of the following classes of data:
 Keyword #1 “yes” (label: yes) (length: 1 seconds)

 Keyword #2 “no” (label: no) (length: 1 seconds)

1 33

# I've pre-loaded in a bunch of background [

noise and unknown words!

29


https://docs.edgeimpulse.com/docs/pre-built-datasets/keyword-spotting
https://docs.edgeimpulse.com/docs/pre-built-datasets/keyword-spotting

https://www.edgeimpulse.com/

blog/public-projects-launch

Clone my starter KWS project:

https://bit.ly/SciTinyML22-KWS

HARVARD
UNIVERSITY
] Dashboard
& Devices
& Data acquisition
A  Impulse design

@® Createimpulse
@ EON Tuner
4 Retrain model
75 Live dassification
Model testing
P  Versioning

Deployment

o

GETTING STARTED

& Documentation

Project info Keys Export - Brian_plancher

Hang

4 Clone this project

Enter a name for the cloned project:

SciTinyML22-KWS

Creatit Summary

Choose your project type:

E © Developer @ DATA COLLECTED
20 min job limit, 4GB or 4 hours of data, limited collaboration 50m 34s
Enterprise
No job or data size limits, higher performance, custom blocks.
Project info
Create under organization: | Harvard University v |
W
Project ID 95912

Project version 1
Clone project

30


https://bit.ly/SciTinyML22-KWS
https://www.edgeimpulse.com/blog/public-projects-launch
https://www.edgeimpulse.com/blog/public-projects-launch

— RESTORE PROJECT (SCITINYM STC ot Bri lanch
— EDGE IMPULSE ] { g,  Brian_plancher

] Dashboard

Clone succeeded

+» Impulse design

You're now ready to build your next embedded Machine Learning project!
® Create impulse

@ EON Tuner
Retrain model Clone progress

[1124/3034] Restoring files... A
[1246/3034] Restoring files...
[1456/3034] Restoring files...

¢ Live classification

B Model testing [1578/3034] Restoring files...
[17906/3034] Restoring files...
[1980/3034] Restoring files...
P versioning

[2109/3034] Restoring files...
[2279/3034] Restoring files...
Deployment [2479/3034] Restoring files...
[2602/3034] Restoring files...
[2815/3034] Restoring files...
[2938/3034] Restoring files...
GETTING STARTED [3834/3034] Restoring files...
[6/7] Restoring files OK

-

1 Documentation
[7/7] Rewriting caches...

[7/7] Rewriting caches OK
%, Forums

Project has been restored!

Job completed



. EDGE IMPULSE

0 Dashboard
¥ Devices
£ Data acquisition

4\ Impulse design
® Createimpulse
@ EON Tuner
Retrain model
7y Live classification
Model testing
P Versioning

@ Deployment

GETTING STARTED
@ Documentation

® Forums

DATA ACQUISITION (SCITINYML22-KWS-TESTCLONE)

Testdata | Exportdata

il Did you know? You can capture data from any device or development board, or upload your existing datasets - Show options

DATA COLLECTED TRAIN / TEST ... Record new data [-e- Connect using WebUSB ]
50m 34s 100% ... &
B No devices connected to the remote management API.
Collected data ) X U
RAW DATA
SAMPLE NAME LABEL ADDED LENGTH
Click on a sample to load...
noise.orig_train... noise Today, 11:2.. 1s
noise.orig_train... noise Today, 11:2.. 1s
noise.orig_train... noise Today, 11:2.. 1s

W |’ve pre-loaded in a bunch of

e Noise and unknown words!

noise.orig_train... noise Today, 11:2.. 1s

Brian_plancher
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DATA ACQUISITION (SCITINYML22-KWS-TESTCLONE)

Testdata | Exportdata

Brian_plancher

il Did you know? You can capture data from any device or development board, or upload your existing datfllets - Show options

DATA COLLECTED TRAIN / TEST ...
50m 34s ‘, 100%... 4 o

Record new data [ & Connect using WebUSB ]

B No devices connected to the remote management API.

Collected data b ¢ L O
DATA
SAMPLE NAME LABEL ADDED LENGTH
Click on a sample to load...

noise.orig_train... noise Today, 11:2.. 1s H
noise.orig_train... noise Today, 11:2.. 1s H
noise.orig_train... noise Today, 11:2.. 1s H
noise.orig_test.... noise Today, 11:2.. 1s H
noise.orig_train... noise Today, 11:2.. 1s H
noise.running_t... noise Today, 11:2.. 1s H
noise.orig_train... noise Today, 11:2.. 1s H
noise.orig_train... noise Today, 11:2.. 1s H
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This is your Edge Impulse project. From here you acquire new training data, design impulses and train

4 Collect data

You can collect data from development boards, from your own devices, or by uploading an existing dataset.

models.
Crea
t 3
0
W
—
1.
W

Connect a fully supported development board

Get started with real hardware from a wide range of silicon vendors -
fully supported by Edge Impulse.

Use your mobile phone

Use your mobile phone to capture movement, audio or images, and even
run your trained model locally. No app required.

Use your computer

Capture audio or images from your webcam or microphone, or from an
external audio device.

Data from any device with the data forwarder

Capture data from any device or development board over a serial
connection, in 10 lines of code.

Upload data

Already have data? You can upload your existing datasets directly in WAV,

JPG, PNG, CBOR, CSV or JSON format.

[ Browse dev boards ]

——‘

[ Show QR code ] I

> mmai

Collect data ] I

[ Show docs ]

[ Go to the uploader ]

‘Ilabm
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This is your Edge Impulse project. From here you acquire new training data, design impulses and train

models.

Crea

E Get started with real hardware from a wide range of silicon vendors -
fully supported by Edge Impulse.

4 Collect data

You can collect data from development boards, from your own devices, or by uploading an existing dataset.

aring
Connect a fully supported development board

L Browse dev boards }

——q

| Point your phone [ [ e ||
L I I I
camera at the QR E— _mma,
code and open one,orfroman ) [ Collectdate
the link! “—_—— ;
= Capture data from any device or development board over a serial [ Show docs ]
connection, in 10 lines of code. b
Upload data
L Already have data? You can upload your existing datasets directly in WAV, [ Go to the uploader ] l

JPG, PNG, CBOR, CSV or JSON format.
[labot
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@& smartphone.edgeimpulse.com

Connected as phone_kunh8zjd

You can collect data from this device
from the Data acquisition page in the
Edge Impulse studio.

{ @ Collecting images? ’

[ & Collecting audio? ]

‘ "\, Collecting motion? ]

t

37



@& smartphone.edgeimpulse.com

Connected as phone_kunh8zjd

You can collect data from this device
from the Data acquisition page in the
Edge Impulse studio.

& Collecting audio?

t
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@& smartphone.edgeimpulse.com

Connected as phone_kunh8zjd

You can collect data from this device
from the Data acquisition page in the
Edge Impulse studio.

{ @ Collecting images? ’

[ & Collecting audio? ]

‘ "\, Collecting motion? ]

t

@& smartphone.edgeimpulse.com

e=—=

= & Data collection

Label: goodbye Length: 3s.

Category: split

& Start recording

Audio captured with current settings: 0Os

[

39



@& smartphone.edgeimpulse.com

Connected as phone_kunh8zjd

You can collect data from this device
from the Data acquisition page in the
Edge Impulse studio.

{ @ Collecting images? ’

[ & Collecting audio? ]

‘ "\, Collecting motion? ]

t

@& smartphone.edgeimpulse.com

==
=

= & Data collection

Label: goodbye

& Start recording

Audio captured with current settings: 0Os

U
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@ smartphone.edgeimpulse.com (1)

Connected as phone_kunh8zjd

You can collect data from this device
from the Data acquisition page in the
Edge Impulse studio.

[ Collecting images? ’

[ & Collecting audio? ]

‘ "\, Collecting motion? ]

& smartphone.edgeimpulse.com (1

= & Data collection

Label: goodbye Length: 3s.

Category: split

& Start recording

Audio captured with current settings: Os

@ smartphone.edgeimpulse.com

Enter a label

goodbye

OK
Cancel

Suppress Dialogs

41



@ smartphone.edgeimpulse.com (1)

Connected as phone_kunh8zjd

You can collect data from this device
from the Data acquisition page in the
Edge Impulse studio.

{ @ Collecting images? ’

[ & Collecting audio? ]

@& smartphone.edgeimpulse.com

= & Data collection

Label: goodbye Length: 3s.

Category: split

& Start recording

Audio captured with current settings: 0Os

U

] https://docs.edgeimpulse.com/docs/

@ smartphone.edgeimpulse.com

Enter a label

goodbye

OK

Cancel

Suppress Dialogs

using-your-mobile-phone

42


https://docs.edgeimpulse.com/docs/using-your-mobile-phone
https://docs.edgeimpulse.com/docs/using-your-mobile-phone
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DATA ACQUISITION (SCITINYML22-KWS-TESTCLONE)

Testdata | Exportdata

i

DATA COLLECTED
50m 34s

Collected data

noise.orig_train...

noise.orig_train...

noise.orig_train...

noise.orig_test....

noise.orig_train...

noise.running_t...

noise.orig_train...

noise.orig_train...

)

LABEL

noise

noise

noise

noise

noise

noise

noise

noise

TRAIN / TEST ..

100% ...

Today, 11:2...

Today, 11:2...

Today, 11:2...

Today, 11:2...

Today, 11:2...

Today, 11:2...

Today, 11:2...

Today, 11:2...

Did you know? You can capture data from any device or development board, or upload your existing datasets - Show options

. O

L

LENGTH

1s

e
[

Brian_plancher

Record new data [ & Connect using WebUSB ]

B No devices connected to the remote management API.

T

Click on a sample to load...

43



You may need to re-flash
the El Firmware!

1. Double tap RESET to enter bootloader mode

2. Download the firmware: bit.ly/EI-Nano33-Firmware

3. Run the flash script for your operating system
(flash windows.bat, flash mac.command or
flash linux.sh).

4. Wait until flashing is complete, and press the RESET button once
to launch the new firmware.

44


https://bit.ly/EI-Nano33-Firmware
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DATA ACQUISITION (SCITINYML22-KWS-TESTCLONE)

Testdata | Exportdata

i

DATA COLLECTED
50m 34s

Collected data

noise.orig_train...

noise.orig_train...

noise.orig_train...

noise.orig_test....

noise.orig_train...

noise.running_t...

noise.orig_train...

noise.orig_train...

)

LABEL

noise

noise

noise

noise

noise

noise

noise

noise

TRAIN / TEST ..

100% ...

Today, 11:2...

Today, 11:2...

Today, 11:2...

Today, 11:2...

Today, 11:2...

Today, 11:2...

Today, 11:2...

Today, 11:2...

Did you know? You can capture data from any device or development board, or upload your existing datasets - Show options

. O

L

LENGTH

1s

e
[

Brian_plancher

Record new data [ & Connect using WebUSB ]

B No devices connected to the remote management API.

T

Click on a sample to load...
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Cl

sl

{ ﬂ studio.edgeimpulse.com/studio/94879/acquisition/training?page=

...dgeimpulse.com wants to connect to a serial port

-]
Nano 33 BLE (ttyACMO) - Paired v
ttyS0

ttyS1

tyS10

ttyS11

tys12

ttys13 '

ttyS14

'dc’ CRIFNTC ATANIT
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DATA ACQUISITION (SCITINYML22-KWS-TESTCLONE) ' Brian_plancher
b

Testdata | Exportdata

1l Did you know? You can capture data from any device or development board, or upload your existing datasets - Show options

ATA LECTE A s
DATA COLLECTED TRAIN / TEST SPLIT Record new data
50m 34s 100% /0% &

Device ®

v : o
Collected data Y o = 6F:E3:48:F3:11:23 a4
SAMPLE NAME LABEL ADDED LENGTH
Sample length (ms.)
noise.orig_train.Hallway_1.wav.70... noise Today, 11:22:57 1s
10000
noise.orig_train.Metro_1.wav.2970... noise Today, 11:22:57 1s
noise.orig_train.CafeTeria_1.wav.2... noise Today, 11:22:57 1s
Built-in microphone v 16000Hz v

noise.orig_test.Babble_4.wav.2000 noise Today, 11:22:57 1s
noise.orig_train.AirportAnnounce...  noise Today, 11:22:57 1s H
noise.running_tap.wav.29000 noise Today, 11:22:57 1s

RAW DATA
noise.orig_train.Station_1.wav.203... noise Today, 11:22:57 1s o

Click on a sample to load...
noise.orig_train.AirConditioner_9....  noise Today, 11:22:57 1s i
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DATA ACQUISITION (SCITINYML22-KWS-TESTCLONE) Brian_plancher
b

Testdata | Exportdata

1l Did you know? You can capture data from any device or development board, or upload your existing datasets - Show options

Ao LECTE " STS
DATA COLLECTED TRAIN / TEST SPLIT Record new data
50m 34s 100% / 0% &

Device ®

v : Lo
Collected data Y o = 6F:E3:4B:F3:11:23 ¥
LABEL ADDED LENGTH

Label Sample length (ms.)

noise.orig_train.Hallway_1.wav.70... noise Today, 11:22:57 1s
yes 10000

noise.orig_train.Metro_1.wav.2970... noise Today, 11:22:57 1s

Sensor Frequency
noise.orig_train.CafeTeria_1.wav.2... noise Today, 11:22:57 1s

Built-in microphone v 16000Hz v
noise.orig_test.Babble_4.wav.2000 noise Today, 11:22:57 1s
noise.orig_train.AirportAnnounce...  noise Today, 11:22:57 1s
noise.running_tap.wav.29000 noise Today, 11:22:57 1s
DATA

noise.orig_train.Station_1.wav.203... noise Today, 11:22:57 1s .

Click on a sample to load...
noise.orig_train.AirConditioner_9... noise Today, 11:22:57 1s H

48



50m 44s

Collected data

yes.30u50kgq

noise.orig_train.Hallway_1.wav.7..

( noise.orig_train.Metro_1.wav.297...

noise.orig_train.CafeTeria_1.wav....

noise.orig_test.Babble_4.wav.2000

noise.orig_train.AirportAnnounc...

noise.running_tap.wav.29000

noise.orig_train.Station_1.wav.20...

noise.orig_test.Typing_1.wav.160...

noise.orig_train.SqueakyChair_9....

u nmse.orlg_tram‘Alrpor[Announc -

noise.orig_train.AirConditioner_9...

9

noise

noise

noise

noise

noise

noise

noise

100% /0% A

o Record new data

Device @
Y = $
" 8 3 6FE3:4B:F3:11:23 v
Label Sample length (ms.)
10s H Sensor Frequency

Built-in mic

1s H
Start samplin

RAW D/

yes.30u5okgq

» 0:00/0:00




SAMPLE NAME

yes.30u5o0kgq

noise.orig_train.Hallway_1.wav.7...

noise.orig_train.Metro_1.wav.297...

noise.orig_train.CafeTeria_1.wav....

noise.orig_test.Babble_4.wav.2000

noise.orig_train.AirportAnnounc...

noise.running_tap.wav.29000

nAicn Aviar train Cratian 1 waarmare 20N

LABEL

yes

noise

noise

noise

noise

noise

noise

ADDED

Today, 14:24:58

Today, 11:22:57

Today, 11:22:57

Today, 11:22:57

Today, 11:22:57

Today, 11:22:57

Today, 11:22:57

Tad-: 14.747.Cc7

LENGTH

10s

Rename

Edit label

Move to test set

Disable

Download

Delete

50



[# Split sample 'yes.30u50kgq'

| Q Zoom | 1 + Add Segment | Set segment length (ms.): NSl

i

Cancel




[# Split sample 'yes.30u50kgq'

| Q Zoom | 1 + Add Segment I Set segment length (ms.):  lele)

i

Cancel Shift sam




[# Split sample 'yes.30u50kgq'

Cancel Shift sam




[# Split sample 'yes.30u5okgq'

( Q Zoom ] ‘ + Add Segment ] Set segment length (ms.): _

Remove segment

» 0:00/0:00




[# Split sample 'yes.30u5okgq'

( Q Zoom ] ‘ + Add Segment ] Set segment length (ms.): _

Remove segment

» 0:00/0:00




DATACOLLECTEL TRAIN/ ESTSPOT Record new data
50m 39s 100% /0% &

Device @
L HH
Collected data A = 6FE3:4B:F3:11:23 i
Label Sample length (ms.)
yes 10000
yes.30u50kgq.s5 ) 4:31:19 s H Sensor Frequency
yes.30u5okgq.s4 s 19 s $ Built-in microphone v 16000Hz v

yes.30u50kgq.s3
yes.30u5okgq.s2

yes.30u5okgq.s1

yes.30u5o0kgq.s5

O noise.orig_train.Metro_1.wav.297... noise

O noise.orig_train.CafeTeria_1.wav....

(]} noise.orig_test.Babble_4.wav.2000 noise

O noise.orig_train.AirportAnnounc..

] noise.running_tap.wav.29000 noise

U noise.orig_train.Station_1.wav.20...

‘ » 0:00 /0:00
< 2 4 5 254 >

56



Activity: Create a Keyword Spotting Dataset

Collect of the following classes of data:
 Keyword #1 “yes” (label: yes) (length: 1 seconds)

 Keyword #2 “no” (label: no) (length: 1 seconds)

We’ll resume in 10 minutes!

S57
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[ Dashboard

£ Data acquisition
“\  Impulse design

@® Create impulse
@ EON Tuner

Retrain model
73 Live dlassification
@ Model testing

PP versioning

o

Deployment

GETTING STARTED
g Documentation

% Forums

Scroll Down to the Bottom

Danger zone

Perform train / test split

Launch getting started wizard
Transfer ownership

Delete this project

Delete all data in this project
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— - EDGE IMPULSE

O Dashboard
# Devices
£ Data acquisition
“ Impulse design

®  Createimpulse
@ EONTuner

Retrain model
7y Live classification
@ Model testing
P versioning

Deployment

o

GETTING STARTED

@ Documentation

% Forums

DATA ACQUISITION (SCITINYML22-KWS

Testdata | Exportdata

.

DATA COLLECTED
40m 29s

Collected data

SAMPLE NAME

no.30u6blbcn.s5
no.30u6blbcn.s4
no.30u6blbcn.s3
no.30u6lbcn.s2
no.30u6lbcn.s1
no.30u6k9u9.s5

no.30u6k9u9.s4

e mALflAaLA A

CLONE)

LABEL

no

no

no

no

no

no

no

TRAIN / TEST SPLIT
80% /20% A

ADDED

Today, 14:40:46

Today, 14:40:46

Today, 14:40:46

Today, 14:40:46

Today, 14:40:46

Today, 14:40:13

Today, 14:40:13

Did you know? You can capture data from any device or development board, or upload your existing datasets - Show options

LENGTH

1s

1s
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DATA ACQUISITION - TESTING (SCITINYML22-KWS-TESTCLONE)

Training date Export data

One or more of the DEIS
e Did you know? You can capture data from any dejiiigs T ey I U pload your exis

train /t

learn he

DATA COLLECTED

10m 20s ‘,

Collected data b | & I
SAMPLE NAME LABEL ADDED LENGTH
noise.orig_train.Metro_1... noise Today, 11:22:57 1s
noise.orig_train.CafeTeri... noise Today, 11:22:57 1s :
noise.orig_train.AirCond... noise Today, 11:22:57 1s :
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() Dataset train / test split ratio X

Training data is used to train your model, and testing data is used to test your model's accuracy after training.
We recommend an approximate 80/20 train/test split ratio for your data for every class (or label) in your dataset,
although especially large datasets may require less testing data.

SUGGESTED TRAIN / TEST SPLIT 809% / 20%

Labels in your dataset @
The 'no’ class has a poor train/test split ratio. To fix this, add or move samples to the training or testing data.

NO 100% / 0% (27s / Os)

NOISE 809 / 20% (20m 22s / 5m 13s)

UNKNOWN 80% / 20% (19m 52s / 5m 7s)

YES 81% / 19% (22s / 55)

Perform train / test split

Use this option to rebalance your data, automatically splitting items between training and testing datasets.

Warning: this action cannot be undone.
Perform train / test split
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Collected data

SAMPLE NAME

no.30u8qcvh.s1

no.30u6k9u9.s5

no.30u6k9u9.s1

no.30u8qcvh.s9

no.30u8qcvh.s7

yes.30u8rq7l.s8

yes.30u8rq7l.s7

LABEL

no

no

no

no

no

yes

yes

ADDED

Today, 15:22:58

Today, 15:22:5

Today, 15:22:5

Today, 15:22:4

Today, 15:22:4

Today, 15:20:1

Today, 15:20:1

b ¢ L O

LENGTH

1s

Rename

Edit label

Move to test set
Disable

Crop sample
Split sample
Download

Delete
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B Dataset train / test split ratio X

Training data is used to train your model, and testing data is used to test your model's accuracy after training.
We recommend an approximate 80/20 train/test split ratio for your data for every class (or label) in your dataset,
although especially large datasets may require less testing data.

SUGGESTED TRAIN / TEST SPLIT 80% / 20%

Labels in your dataset @

The 'no’ class has a poor train/test split ratio. To fix this, add or move samples to the training or testing data.

NO 81% 7/ 19% (22s / 55)

NOISE 80% / 20% (20m 22s / 5m 13s)

UNKNOWN 80% /7 20% (19m 52s / 5m 7s)

YES 81% / 19% (22s / 55)
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Today’s Agenda

® A Quick Review of What We’ve Learned

e Data Engineering for KWS

® Hands-on KWS Data Collection with Edge Impulse
® (Hands-on) Data Preprocessing for KWS

® Deploying our Model onto our Arduino

Summary
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Edge Impulse Project Dashboard

v

Collect Preprocess Design a Traina Evaluate Convert Deploy Make
Data Data Model Model Optimize Model Model Inferences

O0-0-0-0

Dataset

v

Impulse

Test

Deploy

0

sias
-uu

>

&

l\é’

T &

=

Dashboard

Devices

Data acquisition

Impulse design

® Create impulse

EON Tuner

Retrain model

Live classification

Model testing

Versioning

Deployment
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Why might we want to preprocess data and not
send the raw data to the neural network?

unknown.2hvfrhdt
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Can you tell these two signals apart?

“Yes” (spoken loudly)

20000

10000

-10000 -

—20000 -

—10000 -

—20000 -

20000

40000

60000

80000

“No” (spoken loudly)

20000 -

10000

20000

40000

60000

80000
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Signal Components?

~S
Vi

AWAY
\V%
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Signal Components?

N

N

—10000 -

—20000 -

“No” (spoken loudly)

20000 -

10000

20000

40000

60000

80000
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Fast Fourier Transform:
extract the frequencies from a signal

/ frequency
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Fast Fourier Transform

No Loud

o

10° 10t 10?

Frequency

00000

000000

000000

No Loud

Time
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Building a Spectrogram using FFTs

No Loud

000000

000000

—20000 A
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Building a Spectrogram using FFTs

~ No Loud

000000

000000

—20000 A
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Building a Spectrogram using FFTs

No Loud

000000

000000

—20000 A
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Building a Spectrogram using FFTs

No Loud No Loud

20000 A

10000 A

—-10000 A

—20000 A

0 20000 40000 60000 80000 0 200 400 600 800 1000

Essentially if you stack up all the FFTs in a row
then you get the Spectrogram (time vs. frequency
with color indicating intensity) 75




ectrograms help differentiate the data

Yes Loud Yes Quiet
20000 20000
10000 10000
) 0
-10000 -10000
-20000 -20000
0 20000 40000 60000 80000 0 10000 20000 30000 40000 50000 60000 70000
No Loud No Quiet
20000 20000
10000 10000
0 0
~10000 10000
20000 20000
(I) 20600 40600 50600 80(300 6 20600 40600 60600 80600



Spectrograms help differentiate the data

Yes Loud Yes Quiet

400 600

400 600

No Loud No Quiet

150

200
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Spectrograms help differentiate the data

Yes Quiet

Yes Loud

400 600

400 600

No Loud No Quiet

150

200
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A spectrogram is also effectively

an image that we can use as an
input to a CNN!
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Can we do better than a
spectrogram??

Can we take domain knowledge
Into account?
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Mel Filterbanks

0.8

€ 0.6
=

S 04}

0.2

Frequency / mel

1263 1526 1789 2051 2314 2577

0.0 ' L
1000 2000 3000

i & | |
4000 5000 6000 7000 8000

Frequency / Hz
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Spectrograms v. MFCCs

Yes Loud

Yes Loud

100
125
150
175

200

400 600

No Loud

No Loud

100

150

200

83



Spectrograms v. MFCCs

Yes Loud

100
125
150
175
200

400 600

No Loud

100

150

200

Yes Loud

Colab Link
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https://colab.research.google.com/github/tinyMLx/colabs/blob/master/3-5-10-SpectrogramsMFCCs.ipynb

Additional Feature Engineering

Normalization:

remove volume
differences

|

MM\/\W»«/\

Denoise: reduce
background

noise for clarity

>
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WARNING: Whatever preprocessing
you do on the computer in python for

training you need to do in C++ on the
microcontroller!
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Today’s Agenda

® KWS Preprocessing and Training
Preprocessing (for KWS)

Hands-on Preprocessing and Training with Edge Impulse
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== EDGE IMPULSE CREATE IMPULSE (BRIAN_PLANCHER-PROJECT-1) %, Brian_plancher

4N Animpulse takes raw data, uses signal processing to extract features, and then uses a learning block to classify new data.

[ Dashboard
& Devices
€ Data acquisition

Time series data e 5 Output features

LGS Add a processing block i

mpulse design

@® Createimpulse

audio

Window size (©)

Retrain model #

1000 ms.
23 Live classification

Window increase

@

B Model testing

I-’ Versioning

Frequency (Hz)

16000 e

GETTING STARTED Zero-pad data
v

W Deployment

£ Documentation

® Forums
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=- EDGE IMPULSE

[ Dashboard
& Devices
€ Data acquisition

“\  Impulse design

®  Createimpulse
@ EON Tuner

Retrain model
&3 Live classification
B Model testing
¥ Versioning

W Deployment

GETTING STARTED
£ Documentation

® Forums

CREATE IMPULSE (BRIAN_PLANCHER-PROJECT-1) Brian_plancher

4N Animpulse takes raw data, uses signal processing to extract features, and then uses a learning block to classify new data.

Time series data Output features

Axes

Add a processing block Add a learning block

audio

Window size

—_—e

1000 ms.

Window increase (©)

@

500 ms.

Frequency (Hz) @
16000 (&

Zero-pad data

v
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=- EDGE IMPULSE

O Dashboard
& Devices
8 Data acquisition
“+  Impulse design
®  Createimpulse
@ EON Tuner
>¢  Retrain model
s  Live classification

B Model testing

<

Versioning

Deployment

GETTING STARTED
1 Documentation

® Forums

CREATE IMPULSE

4\ Animpulse takes raw data, uses signal proces:

Time series data

Input axes

Window size

Window increase

-®

Frequency (Hz)

16000 (o

Zero-pad data

v

©2022 Edeelmoulse Inc. Al rights reserved

% Add a processing block

Audio (MFCC)

Extracts features from audio signals using Mel Frequency Cepstral
Coefficients, great for human voice.

Audio (MFE)

Extracts a spectrogram from audio signals using Mel-filterbank energy
features, great for non-voice audio.

Flatten

Flatten an axis into a single value, useful for slow-moving averages like
temperature data, in combination with other blocks.

Image

Preprocess and normalize image data, and optionally reduce the color
depth.

Spectral Analysis

Great for analyzing repetitive motion, such as data from
accelerometers. Extracts the frequency and power characteristics of a
signal over time

Spectrogram

Extracts a spectrogram from audio or sensor data, great for non-voice
audio or data with continuous frequencies.

AUTHOR

Edgelmpulse Inc.

Edgelmpulse Inc.

Edgelmpulse Inc.

Edgelmpulse Inc.

Edgelmpulse Inc.

Edgelmpulse Inc.

[ Ada |

((Aaa |

[ Ada |

(Aaa ]

((Aaa ]

block

Brian_plancher

Save Impulse
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PULSE (BR

An impulse

increase

¥ Add a processing block

DESCRIPTION

Audio (MFCC)

Extracts features from audio signals using Mel Frequency Cepstral
Coefficients, great for human voice.

Audio (MFE)

Extracts a spectrogram from audio signals using Mel-filterbank energy
features, great for non-voice audio.

Flatten

Flatten an axis into a single value, useful for slow-moving averages like
temperature data, in combination with other blocks.

Image

Preprocess and normalize image data, and optionally reduce the color
depth.

Spectral Analysis

Great for analyzing repetitive motion, such as data from
accelerometers. Extracts the frequency and power characteristics of a
signal over time.

Spectrogram

Extracts a spectrogram from audio or sensor data, great for non-voice
audio or data with continuous frequencies.

AUTHOR

Edgelmpulse Inc.

Edgelmpulse Inc.

Edgelmpulse Inc.

Edgelmpulse Inc.

Edgelmpulse Inc.

Edgelmpulse Inc.

RECOMMENDED

Add

Add

Add

Add

We’'ll keep things
simple today and just
add an MFCC
but/and in future
projects you can:
e create your
own blocks
e use multiple
blocks

https://docs.edgeimpulse.com/

docs/custom-blocks

91


https://docs.edgeimpulse.com/docs/custom-blocks
https://docs.edgeimpulse.com/docs/custom-blocks

Brian_plancher

CREATE IMPULSE (BRIAN_PLANCHER-PROJECT-1)

=- EDGE IMPULSE

4\ Animpulse takes raw data, uses signal processing to extract features, and then uses a learning block to classify new data.

[ Dashboard
& Devices
S

Data acquisition Time series data Audio (MFCC) o : Output features °

4 Impulse design

Axes Add a learning block

Create impulse ;
4 P audio

@ EON Tuner Window size
B

Input axes

audio

Save Impulse

Retrain model

A Live classification ! y
Window increase

@ Model testing @
500 ms.

P Versioning

Frequency (Hz)
W Deployment 16000 e

L]

Zero-pad data

GETTING STARTED

% A G Sl e b Bl \

L Documentation

% Forums

Add a processing block
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& Add a learning block

Some learning blocks have been hidden based on the data in your project.

DESCRIPTION AUTHOR RECOMMENDED

Classification (Keras)

Learns patterns from data, and can apply these to new data. Great for ~ Edgelmpulse Inc.
categorizing movement or recognizing audio.

Regression (Keras)

Learns patterns from data, and can apply these to new data. Great for ~ Edgelmpulse Inc.
predicting numeric continuous values.

Add a processing block

Add

Cancel
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Time series data Audio (MFCC) o Classification (Keras) e

Axes Name Name

audio MFCC NN Classifier

Window size ®

Output features °

3 (no, unknown, yes)

Input axes Input features

p— audio MFCC

e ]

Save Impulse

Window increase

-®

Output features

3 (no, unknown, yes)

Frequency (Hz)

16000 &

Zero-pad data

v e e N

Add a processing block Add a learning block
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= EDGE IMPULSE

O

Dashboard

Devices

Data acquisition

Impulse design

®  Create impulse

® MFCC

@® NN Classifier

EON Tuner

Retrain model

Live classification

Model testing

Versioning

Deployment

GETTING STARTED

CREATE IMPULSE (BRIAN_PLANCHER-PROJECT-1)

4N Successfully stored impulse. Configure the signal processing and learning blocks in the navigation bar.

Time series data

Axes

audio

Window size

—_——

Window increase

8

Frequency (Hz)

16000 (&

Zero-pad data

v

®

1000 ms.

Audio (MFCC) °

Name

MFCC

Input axes

audio

Classification (Keras) e

Name

NN Classifier

Input features

() MFcc

Output features

3 (no, unknown, yes)

Output features

3 (no, unknown, yes)

Brian_plancher

Save Impulse
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MFCC (BRIAN_PLANCHER-PROJECT-1)

#~ Cli , or this version

l Generate features

Raw data

Raw features

0,0, 0,0 00,0 0,0 0 0,0,0,0,0,0,0,0,0,0,80,0,0,0,0,0,00,0,20,0,.

Parameters

Mel Frequency Cepstral Coefficients
Number of coefficients 13

Frame length 0.02

» 0:00/0:01

DSP result

Cepstral Coefficients

Processed features

-

&

Brian_plancher

unknown.2hvfrhdt (unknown) v
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MFCC (SCITINYML22-KWS-TESTCLONE) Brian_plancher

#1 ~ Click to set a description for this version

Parameters Generate features

Training set Feature explorer ®@
Data in training set 40m 29s No features generated yet.

Classes 4 (no, noise, unknown, yes)

Training windows 2,429

Generate features

© 2022 Edgelmpulse Inc. All rights reserved
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MFCC (SCITINYML22-KWS-TESTCLONE)

#1 ¥ C(lick to set a description for this version

Parameters Generate features

Training set

Data in training set 40m 29s

Classes 4 (no, noise, unknown, yes)

Training windows 2,429

Feature generation output Cancel

Creating job... OK (ID: 2596741)

Scheduling job in cluster...

Job started

Ccreating windows from 2429 files...
[2/3] Pre-caching files...

[3/3] Pre-caching files...
Pre-caching files OK

[ 1/2429] Creating windows from files...

Feature explorer

No features generated yet.

»

Brian_plancher
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Feature explorer (2,494 samples) €]

X Axis Y Axis Z Axis

Visualization layer 1 v Visualization layer 2 4 Visualization layer 3

L no

® noise

e unknown
® yes

If you can visually see the
clustering of the data then it is

ERECRRS - e easier for the ML model to learn!
R - " ' | (But its not required and provides
3 N | no guarantees)

noise.pink_noise.wav.20000
Label: noise
View sample

View features

b 0:00/00] m——m——— ) i
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Feature explorer (2,494 samples) ®

X Axis

Visualization layer 1 v

no
noise
unknown
yes

13

125

A2

o\
\’c“\‘”
-
-~
w

noise.pink_noise.wav.20000
Label: noise

View sample

View features

Visualization layer 2 4

-20000

-40000

Y Axis Z Axis

Visualization layer 3 v

40000
20000

.aud!o

(0]

0 104 208 312 416 520 624 728 832 936

> 0:00/0:0] =—— )

Feature explorer (1,506 samples) ®
X Axis Y Axis Z Axis
accX RMS v accY RMS v accZ RMS v

® idle
® updown
e walk

accX Riys

updown.9.1cjh52qu
Window: 4608 - 6608 ms.
Label: updown

10 W .accx
0. 2opsy s .ach
-10 .ach

View features -20
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b—) MFCC (SCITINYML. y
— EDGE IMPULSE ot 4 Brian_plancher

#1~ Clic or this ve
= Parameters Generate features
J Dashboard
# Devices s
Training set Feature explorer (2,494 samples) ®
&8 Data acquisition
A Impulse design Data in training set 41m 34s X Axis Y Axis Z Axis
® Create impulse Visualization layer 1 i Visualization layer 2 N Visualization layer 3 v
Classes 4 (no, noise, unknown, yes)
® no
Training windows 2494 ® noise
@ NN Cassifier ®  unknown
® yes
13
Retrain model Generate features
Live classification
¥ Model testing %
Feature generation output
P Versioning e -- e
still running. .. = 25
% completed 156 / 508 epochs ’
L eployment completed 208 / 508 epochs b
Still running...
completed 258 / S@@ epochs o N 5
A0 <
5 leted 308 / 506 h \
TING STARTED S “pochs. 7 N ,
still running...
completed 358 / 568 epochs
f Documentation completed 468 / 568 epochs
Still running... noise.pink_noise.wav.20000
® Forums completed 456 / 508 epochs W ..mj o
wed Apr 27 19:18:09 2622 Finished embedding abelnoise
Reducing dimensions for visualizations OK View sal
View features
Job completec |
v

312 416

P 0:00/001 m——m——— ) i

on-device performance @

PROCESSING TIME PEAK RAM USAGE
168 ms. 17 KB

401



NN CLASSIFIER (SCITINYML22-KWS-TESTCLONE)

#1 v Click to set a description for this version

Neural Network settings H
- . &5 Switch to Keras (expert) mode
Training settings
@ Edit as iPython notebook
Number of training cycles ® 100
Learning rate ® 0.005
Validation set size @ 20 %

Auto-balance dataset @

Audio training options

Data augmentation @

Neural network architecture

Architecture presets @ 1D Convolutional (Default) 2D Convolutional

Input layer (650 features)

‘ L3 Reshape layer (13 columns) Z w ’

| 1D conv / pool layer (8 neurons, 3 kernel size, 1 layer) | 1 02



Neural Network settings

Model Design with
Edge Impulse ;

Learning rate ® 0.0001

Minimum confidence rating ® 0.80

Pre-made neural network

Neural network architecture

Input layer (637 features)

“blocks” that you can add!

Reshape layer (13 columns)

1D conv / pool layer (10 neurons, 5 kernel size)

1D conv/ pool layer (30 neurons, 5 kernel size) ‘
Flatten layer I

Output layer (5 features)




Neural network architecture

° ° 1 import tensorflow as tf
O e e S I I l WI 2 from tensorflow.keras.models import Sequential
3 from tensorflow.keras.layers import Dense, InputLayer,

Dropout, ConvlD, Conv2D, Flatten, Reshape, MaxPoolinglD,
MaxPooling2D, BatchNormalization
e I I l u Se from tensorflow.keras.optimizers import Adam
sys.path.append('./resources/libraries"')
import ei_tensorflow.training

model = Sequential()
channels = 1
11 columns = 13
12 rows = int(input_length / (columns * channels))

13 model.add(Reshape((rows, columns, channels), input_shape
your own TensorFlow code L st Rl

14 model.add(Conv2D(8, kernel_size=3, activation='relu',
kernel_constraint=tf.keras.constraints.MaxNorm(1),
padding="same"'))

15 model.add(MaxPooling2D(pool_size=2, strides=2, padding
="same"'))

16 model.add(Dropout(@.25))

17 model.add(Conv2D(16, kernel_size=3, activation="relu',
kernel_constraint=tf.keras.constraints.MaxNorm(1),
padding="same"'))

18 model.add(MaxPooling2D(pool_size=2, strides=2, padding
="same"))

19 model.add(Dropout(@.25))

20 model.add(Flatten())

21 model.add(Dense(classes, activation="softmax', name="y_pred’'

D))

4
5
6
7
8 # model architecture
g
10

“Expert” mode to write




Neural network architecture Neural network architecture

Architecture presets ® 1D Convolutional (Default) 2D Convolutional 1 import tensorflow as tf
2 from tensorflow.keras.models import Sequential
3 from tensorflow.keras.layers import Dense, InputlLayer, Dropout, ConviD, Conv2D,

Flatten, Reshape, MaxPoolinglD, MaxPooling2D, BatchNormalization,
Input layer (650 features) TimeDistributed
4  from tensorflow.keras.optimizers import Adam

6 # model architecture

.add(Reshape((int(input_length / 13), 13), input_shape=(input_length, )))

Reshape layer (13 columns)
.add(ConvlD(8, kernel_size=3, activation='relu', padding='same'))
.add(MaxPoolinglD(pool size=2, strides=2 adding="same"'))

1D conv / pool Iayer (8 neurons, 3 kernel size, 1 Iayer) 12 model.add(ConviD(16, kernel_size=3, activation='relu', padding='same'))
13 model.add(MaxPoolinglD(pool_size=2, strides=2, padding='same'))

14 model.add(Dropout(@.25))

15 model.add(Flatten())

Dropout (rate 0.25) 16 model.add(Dense(classes, activation='softmax', name='y_pred'))

18 # this controls the learning rate

19 opt = Adam(1lr=0.005, beta_1=0.9, beta_2=0.999)

1D conv / pool Iayer(‘l6 neurons, 3 kernel size, 1 Iayer) 20 # this controls the batch size, or you can manipulate the tf.data.Dataset objects
yourself

21 BATCH_SIZE = 32

22 train_dataset = train_dataset.batch(BATCH_SIZE, drop_remainder=False)

Dropout (rate 0.25) 23 validation_dataset = validation_dataset.batch(BATCH_SIZE, drop_remainder=False)
24 callbacks.append(BatchLoggerCallback(BATCH_SIZE, train_sample_count))
25
26 # train the neural network
Flatten Iayer 27 model.compile(loss="'categorical_crossentropy', optimizer=opt, metrics=[‘accuracy'])

28 model.fit(train_dataset, epochs=100, validation_data=validation_dataset, verbose=2,
callbacks=callbacks)

Add an extra layer

utput layer (3 features)

Start training
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Neural network architecture Neural network architecture

Architecture presets @ 1D Convolutional (Default) 2D Convolutional 1 import tensorflow as tf
2 from tensorflow.keras.models import Sequential
3 from tensorflow.keras.layers import Dense, InputLayer, Dropout, ConvlD, Conv2D,

Flatten, Reshape, MaxPoolinglD, MaxPooling2D, BatchNormalization,
Input layer (650 features) TimeDistributed
from tensorflow.keras.optimizers import Adam

4

5

6 # model architecture
7

8

model = Sequential()
model.add(Reshape((int(input_length / 13), 13), input_shape=(input_length, )))
9 model.add(ConviD(8, kernel_size=3, activation='relu’, padding='same'))
10 model.add(MaxPoolinglD(pool_size=2, strides=2, padding='same'))
11  model.add(Dropout(@.25))
1D conv/ pool Iayer (8 neurons, 3 kernel size, 1 Iayer) 12 model.add(ConviD(16, kernel_size=3, activation='relu', padding='same'))
13 model.add(MaxPoolinglD(pool_size=2, strides=2, padding='same'))
14 model.add(Dropout(@.25))
15 model.add(Flatten())
Dropout (rate 0.25) 16 model.add(Dense(classes, activation='softmax', name='y_pred'))

Reshape layer (13 columns)

18 # this controls the learning rate
19 opt = Adam(1lr=0.005, beta_1=0.9, beta_2=0.999)
1D conv / pool layer (16 neurons, 3 kernel size, 1 layer) 20 # this controls the batch size, or you can manipulate the tf.data.Dataset objects
yourself
21 BATCH_SIZE = 32
train_dataset = train_dataset.batch(BATCH_SIZE, drop_remainder=False)
ase da aset.ba

Dropout (rate 0.25)

r=False)

Flatten layer

For now just stick with the
defaults but/and you can
easily design any model you
want and use any optimizer
you want using Tensorklow!

Add an extra layer

Output layer (3 features)

Start training

106



WARNING: if you want to deploy to a
microcontroller make sure you only use
Ops supported by TensorFlow Lite Micro!

https://qgithub.com/tensorflow/tflite-micro/
blob/main/tensorflow/lite/micro/all ops r
esolver.cc#lL 22



https://github.com/tensorflow/tflite-micro/blob/main/tensorflow/lite/micro/all_ops_resolver.cc#L22
https://github.com/tensorflow/tflite-micro/blob/main/tensorflow/lite/micro/all_ops_resolver.cc#L22
https://github.com/tensorflow/tflite-micro/blob/main/tensorflow/lite/micro/all_ops_resolver.cc#L22

Neural network architecture Neural network architecture

Architecture presets @ 1D Convolutional (Default) 2D Convolutional 1 import tensorflow as tf
2 from tensorflow.keras.models import Sequential
3 from tensorflow.keras.layers import Dense, InputLayer, Dropout, ConvlD, Conv2D,

Flatten, Reshape, MaxPoolinglD, MaxPooling2D, BatchNormalization,
Input layer (650 features) TimeDistributed
from tensorflow.keras.optimizers import Adam

4
5
6 # model architecture
7
8

model = Sequential()
model.add(Reshape((int(input_length / 13), 13), input_shape=(input_length, )))
9 model.add(ConviD(8, kernel_size=3, activation='relu’, padding='same'))
10 model.add(MaxPoolinglD(pool_size=2, strides=2, padding='same'))
11  model.add(Dropout(@.25))
1D conv/ pool Jayer (8 neurons, 3 kernel size, 1 Iayer) 12 model.add(ConviD(16, kernel_size=3, activation='relu', padding='same'))
13 model.add(MaxPoolinglD(pool_size=2, strides=2, padding='same'))
14 model.add(Dropout(@.25))
15 model.add(Flatten())
Dropout (rate 0.25) 16 model.add(Dense(classes, activation='softmax', name='y_pred'))

Reshape layer (13 columns)

18 # this controls the learning rate
19 opt = Adam(1lr=0.005, beta_1=0.9, beta_2=0.999)
1D conv / pool layer (16 neurons, 3 kernel size, 1 layer) 20 # this controls the batch size, or you can manipulate the tf.data.Dataset objects
yourself
21 BATCH_SIZE = 32
train_dataset = train_dataset.batch(BATCH_SIZE, drop_remainder=False)
ase da aset.ba

r=False)

Dropout (rate 0.25)

Flatten layer

For now just stick with the
defaults but/and you can
easily design any model you
want and use any optimizer
you want using Tensorklow!

Add an extra layer

Output layer (3 features)
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Training output

Epoch
4/4 -
Epoch
4/4 -
Epoch
4/4 -
Epoch
4/4 -
Epoch
4/4 -
Epoch
4/4 -

Finished training

95/100

0s - loss:
96/100

0s - loss:
97/100

@s - loss:
98/100

@s - loss:
99/100

0s - loss:
100/100
0s - loss:

0.

.1044

.0256

.0523

.0451

.0514

0348

accuracy:

accuracy:

accuracy:

accuracy:

accuracy:

accuracy:

Training Set

.9500

.0000

.9800

.9800

.9900

.9900

val_loss:

val_loss:

val_loss:

val_loss:

val_loss:

val_loss:

.2934

.3830

.4366

.4265

.3926

+3571

val_accuracy:

val_accuracy:

val_accuracy:

val_accuracy:

val_accuracy:

val_accuracy:

Validation Set

.9231

.8846

.8462

.8846

.8846

«9231

109



Model Model version: @ | Quantized (ints) »

Last training performance (vaiidation set)

Final Accuracy %6.6% 0 ..

Confusion matrix (validation set)

Feature explorer (full training set) @

no - correct
noise - correct
unknown - correct
yes - correct

noise - incorrect
unknown - incorrect

e e e o e

yes - incorrect

noise.orig_test.Neighbor_6.wav.8000

Label: noise

Predicted: noise 1000

P 0:00/0:01 =—— )

On-device performance @

INFERENCING TIME PEAK RAM USAGE FLASH USAGE
11 ms. 5.0K 34.8K
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Final Accuracy

Accuracy Breakdown

Model

Last training performance (validation set)

ACCURACY LOSS

96.6% 0.09

Confusion matrix (validation set)

Feature explorer (ull training set) @

no - correct

noise - correct
unknown - correct
yes - correct
noise - incorrect

unknown - incorrect

e e e o e

yes - incorrect

noise.orig_test.Neighbor_6.wav.8000
Label: noise

Predicted: noise

Model version: ® |

» 0:00/0:01

On-device performance @

INFERENCING TIME PEAK RAM USAGE
11 ms. 5.0K

—_— 0

FLASH US
e 34.8K

Quantized
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Confusion Matrix

Actual Output = Yes Actual Output = No

Predicted Output = Yes

# of False Positive

# of True Positive Type 1 Error

Predicted Output = No

# of False Negative

Type 2 Error # of True Negative
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Final Accuracy

Accuracy Breakdown

Feature Explorer

Individual Data Points

Model Model version: @ | Quantized (ints) »

Last training performance (validation set)

ACCURACY LOSS

96.6% 0.09

Confusion matrix (validation set)

NKNOWN

Feature explorer (full training set) @

no - correct
noise - correct
unknown - correct
yes - correct
noise - incorrect

unknown - incorrect

R

yes - incorrect

noise.orig_test.Neighbor_6.wav.8000

Label: noise

Predicted: noise 00

ple 0

P> 0:00/001 =——— ) i

On-device performance @

INFERENCING TIME OF RAM
@ 11 ms. @ 5.0K 34.8K

113



Final Accuracy

Accuracy Breakdown

Feature Explorer

Individual Data Points

Expected runtime/memory

Model

Last training performance (validation set)

ACCURACY

96.6%

Confusion matrix (validation set)

Feature explorer (full training set) @

no - correct
noise - correct
unknown - correct
yes - correct
noise - incorrect

unknown - incorrect

e e e o0 e oo

yes - incorrect

noise.orig_test.Neighbor_6.wav.8000
Label: noise

Predicted: noise

On-device performance @

INFERENCING TIME
11 ms.

» 0:00/0:01

PEAK RAM USAGE

5.0K

Model version: @ | Quantized (ints) ~

)

FLASH USAGE

34.8K
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1 Dashboard
P Devices

€ Data acquisition
, A\ Impulse design
J J J J /O Create impulse
Collect Preprocess Design a Traina Evaluate Convert Deploy Make
Data Data Model Model Optimize Model Model Inferences © MFCC

@ EON Tuner
Dataset Impulse Test Deploy
75 Live classification

/ / Model testing

f*  Versioning

Edge Impulse Project Dashboard J

Retrain model
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Today’s Agenda

® A Quick Review of What We’ve Learned

e Data Engineering for KWS

® Hands-on KWS Data Collection with Edge Impulse

® (Hands-on) Data Preprocessing for KWS

® Deploying our Model onto our Arduino
Summary
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Edge Impulse Project Dashboard /

v

Evaluate e Convert
Optimize Model

O0-0

Dataset Impulse

https://www.edgeimpulse.com/blog/introduc
ing-the-eon-tuner-edge-impulses-new-auto
ml-tool-for-embedded-machine-learning

1 Dashboard

P Devices

Data acquisition

Impulse design

/. Create impulse
J. MFCC

J. NN Classifier

EON Tuner
Retrain model

Live classification

Model testing

Versioning

% Deployment 117
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1 Dashboard
P Devices

€ Data acquisition

, A\ Impulse design
J J J J J / Create impulse
Collect Preprocess Design a Traina Evaluate Convert Deploy Make
Data Data Model Model Optimize Model Model Inferences © MFCC

@ EON Tuner
Dataset Impulse Test Deploy
% Live classification

/ / Model testing

f*  Versioning

Edge Impulse Project Dashboard /

Retrain model




.__'-.. EDGE IMPULSE DEPLOYMENT (TEST IMAGE 2)

Deploy your impulse

O Dashboard

# Devices You can deploy your impulse to any device. This makes the model run without an internet connection, minimizes latency, and runs
with minimal power consumption. Read more.

& Dataacquisition
Create library

“  Impulse design Turn your impulse into optimized soug

® Createimpulse

®  Transfer learning

@ EON Tuner

Retrain model M <
s
JpenMV
=¢  Live classification NVIDIA. ‘5 p

B Model testing

N~ Build firmware
@ Deployment Get a ready-to-go binary for your development board that includes your impulse.

GETTING STARTED

1 Documentation

’ ro 23 BLE Sense arduino Portenta H7 H WE-| Plu
% Forums I { B taH :
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—- EDGE IMPULSE

O Dashboard
# Devices
& Data acquisition

+

Impulse design

@® Createimpulse

® Image

®  Transfer learning

@ EON Tuner
Retrain model|

£y Live classification

B Model testing

P Versioning

@ Deployment

GETTING STARTED
@ Documentation

%, Forums

Computer

Select optimizations (optional)

Model optimizations can increase on-device performance but may reduce accuracy. Click below to analyze optimizations and see
the recommended choices for your target. Or, just click Build to use the currently selected options.

Enable EON™ Compiler ,'—.-\
Same accuracy, up to 50% less memory. Open source. ——

Available optimizations for Transfer learning

Quantized (int8)

Currently selected

Unoptimized (float32)

Click to select

RAM USAGE LATENCY
66.1K 58 ms
FLASH USAGE ACCURACY
108.1K -

RAM USAGE LATENCY
155.6K 43 ms
FLASH USAGE ACCURACY
193.8K -

120



1 Dashboard
P Devices

€ Data acquisition

, A\ Impulse design
J J J J J J /O Create impulse
Collect Preprocess Design a Traina Evaluate Convert Deploy Make
Data Data Model Model Optimize Model Model Inferences © MFCC

@ EON Tuner
Dataset Impulse Test Deploy
% Live classification

/ / / Model testing

f*  Versioning

Edge Impulse Project Dashboard /

Retrain model




— (BRIAN_PLANCHER-PRO
- EDGE IMPULSE DEVICES (BRIAN_PLANCHER-PROJECT-1)

Brian_plancher

Your devices # Collect data y + Connect a new device

These are devices that are connected to the Edg You can collect data from development boards, from your own devices, or by uploading an existing dataset.

NAME REMOTE ..  LAST SEEN
Connect a fully supported development board
AARRlTRl e deslen Get started with real hardware from a wide range of silicon vendors - Browse dev boards
== phone_kunh8zjd fully supported by Edge Impulse. lamera, ... @ Today, 16:24:48 H
®  Createimpulse X
® MFCC Use your mobile phone
:—__- computer_kq77e063 0 Use your mobile phone to capture movement, audio or images, and eve Show QR code era [ ] Jun 21 2021, 18:41:37 i

@® NN Classifier run your trained model locally. No app required.
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== EDGE IMPULSE

W

Impulse design

Create impulse

MFCC

NN Classifier

AN_PLANCHER-PROJECT-1)

Your devices

These are devices that are connected to the Edg

NAME
== phone_kunh8zd
== computer_kq77e063

4

Connected as phone_kunh8zjd

You can collect data from this device
from the Data acquisition page in the
Edge Impulse studio.

Collecting images? ]

& Collecting audio?

[ "\, Collecting motion? ]

Switch to classification mode

<[> This client is open source.

« Collect data

You can collect data from development boards, from your own devices, or by uploading an existing dataset.

Connect a fully supported development board

Get started with real hardware from a wide range of silicon vendors - Browse dev boards
fully supported by Edge Impulse. lamera, ...
Use your mobile phone

0 Use your mobile phone to capture movement, audio or images, and evel Show QR code era

run your trained model locally. No app required.

REMOTE ...

LAST SEEN

Today, 16:24:48

Jun 21 2021, 18:41:37

Brian_plancher

+ Connect a new device

123



DEVICES (BRIAN_PLANCHE

== EDGE IMPULSE

R-PROJECT-1)

Brian_plancher

Your devices

+ Connect a new device
«# Collect data x
& Devices These are devices that are connected to the Edg You can collect data from development boards, from your own devices, or by uploading an existing dataset.
NAME REMOTE ..  LAST SEEN
| Connect a fully supported development board
i
¥ Impulsedesign Get started with real hardware from a wide range of silicon vendors - Browse dev boards
= phone_kunh8zjd fully supported by Edge Impulse. ° Today, 16:24:48 $
®  Createimpulse X
® MFCC Use your mobile phone
== computer kq77€063 0 Use your mobile phone to capture movement, audio or images, and eve Show QR code ° Jun 21 2021, 18:41:37 i
@® NN Classifier run your trained model locally. No app required.

4

= Classifier

Connected as phone_kunh8zjd

You can collect data from this device
from the Data acquisition page in the
Edge Impulse studio.

[ @ Collecting images? ]

& Collecting aud

[ "\, Collecting motion? ]

Building project...

Job started

Switch to classification mode

Switch to data collection mode

<[> This client is open source. <[> This client is open source.
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== EDGE IMPULSE

¥ Devices

4 Impulse design
®  Createimpulse
® MFCC

® NN Classifier

DEVICES (BRIAN_PLANCHER-PROJECT-1)

Your devices

These are devices that are connected to the Ed|

== phone_kunh8zjd

== computer_kq77e063

4

Connected as phone_kunh8zjd

You can collect data from this device
from the Data acquisition page in the
Edge Impulse studio.

[ @ Collecting images? ]

& Collecting aud

[ "\, Collecting motion? ]

Switch to classification mode

<[> This client is open source.

«# Collect data

You can collect data from development boards, from your own devices, or by uploading an existing dataset.

Connect a fully supported development board

Get started with real hardware from a wide range of silicon vendors -

fully supported by Edge Impulse.

Use your mobile phone

Use your mobile phone to capture movement, audio or images, and evel

run your trained model locally. No app required.

=
-

G

Classifier

Building project...

Job started

Switch to data collection mode

<[> This client is open source.

REMOTE ...

86

85

84

LAST SEEN

Today, 16:24:48

Jun 21 2021, 18:41:37

0.00

0.00

0.00

unknown
NOISE UNKNOWN
0.02 0.98
0.00 1.00
0.00 0.91

Brian_plancher

+ Connect a new device

0.00

0.00

0.09
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Deploy and
Test your
Model

Shows the score for (confidence unknown
that the current sounds is) each of
the various keywords and unknown

and bolds the highest score.

85 0.00 0.00 1.00 0.00

84  0.00 0.00 0.91 0.09
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v

Built Arduino library

Add this library through the Arduino IDE via:
Sketch > Include Library > Add .ZIP Library...

Examples can then be found under:

File > Examples > SciTinyML22-KWS-TestClone_inferencing
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v

Built Arduino library

Add this library through the Arduino IDE via:
Sketch > Include Library > Add .ZIP Library...

Examples can then be found under:

File > Examples > SciTinyML22-KWS-TestClone_inferencing
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nano_ble33_sense_microphone | Arduino 1.8.19 -

File Edit Sketch Tools Help

nano_ble33 sense_microphone
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nano_ble33_sense_microphone | Arduino 1.8.19

File Edit Sketch Tools Help

L

nano_ble33_sense_microphone

ino Nano 33 BLE on /dev/ttyACMO

132



An error occurred while uploading the sketch

Sketch uses 224024 bytes (22%) of program storage space. Maximum is 983040 bytes.
Global variables use 58672 bytes (22%) of dynamic memory, leaving 203472 bytes for local variables. Maximum is 262144 bytes.




1
File Edit Sketch Tools Help

/dev/ttyACMO

Recording done
Predictions (DSP: 205 ms., Classification: 5 ms., Anomaly: 0 ms.):
no: 0.00000
noise: 0.77344
unknown: 0.22656
yes: 0.00000
Starting inferencing in 2 seconds...
Recording. ..
Recording done
Predictions (DSP: 205 ms., Classification: 5 ms., Anomaly: O ms.):
no: 0.00000
noise: 0.05078
unknown: 0.94922
yes: 0.00000
Starting inferencing in 2 seconds...
Recording. ..
Recording done

Predicti (DSP: 205 v Gl ification: 5 v A 1 H H
re ig:lgr.wgeeoo ms assification ms noma Tools > Serlal Monltor

noise: 0.10156

unknown: 0.89062

yes: 0.00781
Starting inferencing in 2 seconds...
Recording. ..
Recording done

Both NL & CR

9600 baud ¥ | Clear output

@ Autoscroll | | Show timestamp
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|
File Edit Sketch Tools Help

/dev/ttyACMO

Recording done
Predictions (DSP: 205 ms., Classification: 5 ms., Anomaly: 0 ms.):
no: 0.00000
noise: 0.77344
unknown: 0.22656

Predictions (DSP: 205 ms., Classification: 5 ms., Anomaly: 0 ms.)

no: 0.00000
noise: 0.10156
unknown: 0.89062

yes: 0.00/81 Confidence that the audio is the
Predictions (DSP: 205 ms., Classification: .
given class (0-1 scale)

no: 0.00000

noise: 0.10156

unknown: 0.89062

yes: 0.00781

Starting inferencing in 2 seconds...
Recording. ..
Recording done

Both NL & CR - 9600 baud ¥ | Clear output

Autoscroll

Show timestamp
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Today’s Agenda

® A Quick Review of What We’ve Learned

e Data Engineering for KWS

® Hands-on KWS Data Collection with Edge Impulse
® (Hands-on) Data Preprocessing for KWS

Deploying our Model onto our Arduino
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Deep Learning
with
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Colab Link

Features can be found with

f'li l‘ \II \

, !H Hl



https://colab.research.google.com/github/tinyMLx/colabs/blob/master/2-3-3-ExploringConvolutions.ipynb

The TinyM L Workflow

Dataset Impulse Test Deploy
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The TinyM L Workflow

COI IeCt Preprocess Design a Train a Evaluate Convert Deploy Make
Data Model Model Optimize Model Model Inferences
Data

Who will use your Where will your
ML model? ML model be used?

Why will your ML model be used?
Why those Keywords?
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The Workflow

P re p rocess Design a Traina Evaluate Convert Make
D at a Model Model Optimize Model Inferences

Yes Loud

FFT, Spectrogram, MFCC
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The Workflow

Confusion
Matrix Actual Output = Yes

Actual Output = No

# of False Positive
Type 1Error

Predicted Output
=Yes

# of True Positive

Predicted Output BE:ReIMz=1E=RNETeFiYE

= No Type 2 Error # of True Negative
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The Workflow

Preprocess Design a Traina Co nve rt Deploy Make
Data Model Model imi M od e I Model Inferences

Reduces the precision of numbers used in
a model which results in:

e smaller model size

e faster computation
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The TinyML Workflow

Preprocess Design a Traina
Data Model Model

Camera

Make
Inferences

Convert
Model

Evaluate
Optimize

G oviers &)

<

B g Edge Impulse
PF: @l Simplifies

G
e
e

o

Magnetometer

Deployment

Microphone
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Better Data = Better Models!




Afrigan Regional WbrkShop $ e
on SciTinyML: S

Scientific Use of s
Machine Learning on . S

Low-Power Devices ) W7

25-29 April 2022
Online

Data Pre-Processing for
Hands-on Keyword Spotting

Brian Plancher 108 100; {2S)
Harvard John A. Paulson School of Engineering and Applied Sciences
Barnard College, Columbia University

brianplancher.com
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https://arduino.qithub.io/arduino-cli/
0.21/installation/

Edge Impulse CLI Notes:

1. Install the Arduino CLI

a. On linux:
curl -fsSL https://raw.githubusercontent.com/arduino/arduino-cli/master/install.sh | sh
On mac:

brew update

brew install arduino-cli

c. Or view the link for binaries

Add to your .bashrc:

# Arduino (CLI)
export PATH="ARDUINO_INSTALL_ LOCATION/bin:$PATH"

Where ARDUINO_INSTALL_LOCATION iS €.Q.,: $HOME/Documents/arduino-1.8.19
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https://arduino.github.io/arduino-cli/0.21/installation/

https://docs.edgeimpulse.com/docs/
edge-impulse-cli/cli-installation

Edge Impulse CLI Notes:

1. Install the Edge Impulse CLI

a. Install Node.js by following the link or on Linux:

curl -sL https://deb.nodesource.com/setup_14.x | sudo -E bash -
sudo apt-get install -y nodejs

Run: npm install -g edge-impulse-cli --force
Add to your .bashrc:

# EI (CLI)
export PATH="$HOME/.npm-global/bin:$PATH"

2. Run edge-impulse-daemon --clean to start the daemon and then follow the instructions in the

terminal to add it to your current project using your edge impulse account!

149
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https://nodejs.org/en/
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https://docs.edgeimpulse.com/docs/edge-impulse-cli/cli-installation

https://docs.edgeimpulse.com/docs/
edge-impulse-cli/cli-installation

Edge Impulse CLI Notes:

o .
#*  Brian_plancher
-,

e i
pey EDGE IMPULSE DEVICES (SCITINYML22-KWS-TESTCLONE)

Your devices + Connect a new device |

[ Dashboard

& Devices These are devices that are connected to the Edge Impulse remote management API, or have posted data to the ingestion SDK.
€ Data acquisition
NAN TYPE SENSORS REMOTE LAST SEEN
4 Impulse design
OO  6rE34B:F3:11:23 6FE3:4BIF3:11:23 ARDUINO_NANO33BLE Built-in accelerometer, Built-n mic.. @ Today, 11:51:59

mmmmm

@ Create impulse
° MFCC
2022 Edgelmpulse Inc. All rights reserved

@® NN Classifier

@ EONTuner

It should then appear on your “Devices” tab in your project!

And then if you go to “Data Acquisition” you should be able
to proceed as you would with the standard instructions!
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